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Agenda

Dymola 2026x
1. MSL 4.1.0
2. Grafische Nutzeroberfläche
3. Modellierung & Simulation
4. Skripting
5. FMI & SSP
6. Bibliotheken
7. Diskussion & Fragen

2025-12-10 Neuigkeiten Dymola 2026x 2



2025-12-10 3

MSL 4.1.0

Neuigkeiten Dymola 2026x



4

Modelica Standard Library 4.1.0

• Die neue MSL Version – eine Übersicht:

• 17 neue Komponenten (z.B. Blöcke um Extrema von Signalen aufzuzeichnen)

• 12 verbesserte Komponenten (z.B. Tabellen können nun CSV Files lesen)

• 18 u.U. nicht rückwärtskompatible Änderungen (insbesondere Constants.inf, Constants.small, 
Constants.eps) ➔ Siehe folgende Folie

• 26 Bugfixes, die u.U. Einfluss auf Simulationsergebnisse haben können

• MSL 4.1.0 basiert auf der Version 3.6 der Modelica Sprache

• Details unter: 
https://github.com/modelica/Modelica/blob/master/Modelica/Resources/ReleaseNotes/Model
ica.UsersGuide.ReleaseNotes.Version_4_1_0.html
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Modelica Standard Library 4.1.0

• Prinzipiell ist die MSL 4.1.0 rückwärtskompatibel (Auto-Konvertierung)

• In der ModelicaServices Bibliothek wurden jedoch globale Konstanten angepasst:

• Das kann u.U. zu anderen Simulationsergebnissen führen , ggf. sogar zum Absturz der Simulation

• Mit dem neuen Flag 
Advanced.Modelica.CompatibilityConstants = true 
können in Dymola 2026x mit MSL 4.1.0 nach wie vor die globalen Konstanten aus MSL4.0.0 genutzt werden 

• ModelicaServices.Machine.small wird z.B. im PI & PID Controller (Modelica.Blocks.Continuous) verwendet

ModelicaServices.
Machine.

4.0.0 4.1.0 description

eps 1.e-15 ~2.22e-16 Biggest number such that 1.0 + eps = 1.0

small 1.e-60 ~2.22e-308 Smallest number such that small and -small are 
representable on the machine

inf 1.e+60 ~1.79+308 Biggest Real number such that inf and -inf are 
representable on the machine
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Modelica Standard Library 4.1.0
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Dymola Version MSL Version
Dymola 2026x 4.1.0
Dymola 2025x 4.0.0
Dymola 2024x 4.0.0
Dymola 2023x 4.0.0
Dymola 2023 4.0.0
Dymola 2022x 4.0.0
Dymola 2022 4.0.0
Dymola 2021x 4.0.0
Dymola 2021 3.2.3
Dymola 2020x 3.2.3
Dymola 2020 3.2.3
Dymola 2019 FD01 3.2.2
Dymola 2017 3.2.2
Dymola 2016 FD01 3.2.1
Dymola 2014 FD01 3.2.1
Dymola 2014 3.2

MSL Version Release Date # Models/Blocks # Examples # Functions

4.1.0 2025-05-23 1430 534 1219

4.0.0 2020-06-04 1417 512 1219

3.2.3 2019-01-23 1288 404 1227

3.2.2 2016-04-03 1600 * 1350

3.2.1 2013-08-14 1360 * 1280

3.2 2010-10-25 1280 * 910

3.1 2009-08-14 923 * 615

* # Examples war in # Models/Blocks enthalten

Die MSL 4.0.0 ist nicht mehr standardmäßig in der Dymola Installation 
enthalten. 
Sie ist aber im "extra"-Ordner den Dymola-Installationsdateien beigefügt: 
(Dymola_2026x.AM_CAT_Dymola.Windows64.1-1.zip\ 
AM_CAT_Dymola.Windows64\1\extra) 
Alternativ können Sie sie aus einer älteren Dymola-Version kopieren oder 
hier herunterladen:
https://www.ltx.de/download/Dymola/ModelicaStandardLibrary_4.0.0.zip
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Anpassung der Menüs

• Das Menüband kann nun angepasst werden:

• Bestehende Buttons können in neuen Menüs und Gruppen zusammengestellt werden

• Bestehende Menüs können nicht angepasst, nur ausgeblendet werden

• Es können keine custom functions angepasst werden > Sie bleiben unter Tools> Custom

• Die Schnellzugriffsleiste kann ebenfalls angepasst werden:

• Hinzufügen, Umsortieren und Entfernen der Buttons möglich

• Darstellung unterhalb der Menüleiste möglich

• Beides erfolgt über Windows>Customize the Ribbon
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Anpassung der Menüs

• Windows>Customize the Ribbon
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Die Anordnung wird in der Datei 
%AppData%\Roaming\DassaultSystemes\Dymola\2026x\ribbon.dymx 
gespeichert und ist somit instanzübergreifend
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Enumerations im Flag Menü
Dymola 2026x

Dymola 2025x Refresh 1

• In Dymola 2026x werden Flags  mit mehreren 
Auswahlmöglichkeiten im Flag Menü als Drop-
Down mit Text angezeigt

• Bislang erfolgte dies mit Zahlen, deren 
Bedeutung man der Description entnehmen 
musste

• Zudem gibt es nun ein Hilfemenü:
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Minor Improvements

Hilfetexte im VariableBrowser

Klickbare Links in Meta-Daten

• Wenn Descriptions der Key-Description Paare von MetaDaten (Documentation > 
MetaData) mit https:// beginnen, werden die entsprechenden Links im Browser geöffnet
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Minor Improvements

Neues Farbschema für Dymola im Dark-Mode
Unter Tools >Options >General > DarkMode kann man Dymola in dunklen Modus darstellen:

Dymola 2025x Refresh 1   Dymola 2026x

Libraries Menü
Einige Bibliotheken unter Open>Libraries wurden in Untermenüs "More Dymola" bzw. 
"More Modelica" zusammengefasst
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Vorauswahl zur Installation externer Bibliotheken
Unter Tools >Library Management >Install git es nun eine Vorauswahl an externen Bibliotheken, die man 
installieren kann (z.B. von github.com):

• Die Vorauswahl ist im Installationsverzeichnis z.B. unter C:\Program Files\Dymola 
2026x\insert\modelicaLibraries.xml hinterlegt und kann angepasst werden

Minor Improvements

2025-12-10 Neuigkeiten Dymola 2026x 13



2025-12-10 14

Modellierung und 
Simulation

Neuigkeiten Dymola 2026x



DataFiles Library: ND-Tables nach Übersetzen austauschbar

• N-Dimensionale Kennfelder mittels des TablesND Blocks aus der DataFiles –Library werden nun erst beim 
Initialisieren eingelesen und können somit auch nach dem Übersetzen angepasst werden

• Dies beruht auf der __Dymola_UnknownArray annotation, die in Dymola 2025x eingeführt wurde. 
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1 2

3 6

5 7

7 8

9 10

11 6

13 7

15 8

17 18

19 20

21 22

23 24

dim = [2;4;3]
grid = [0;3;  0;1;2;3;  0;2;3]
table = [1;2;3;4;5;6;7;8;9;10; ….23;24]
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Definition von Units und DisplayUnits

• Mit der neuen annotation

• __Dymola_UnitDefinitions können in 
TopLevel-Package neue Units und 
neue DisplayUnits definiert werden

• ➔ Eine (physikalische) Größe hat nur 
eine Unit, kann aber mehrere Display 
Units haben

• TopLevel-Package muss dazu 
gespeichert und neu geladen werden

• DisplayUnits konnten bislang auch 
schon in DymolaInstallDir \
insert\displayunit.mos definiert 
werden

• UnitConversions im Package 
überschreiben gleichnamige im 
displayunit.mos

16

package Currencies
model CurrencyExchange

parameter Real one_swedish_crown(unit="EUR")=1/10.96;
parameter Real one_usdollar(unit="EUR") = 1/1.16;

end CurrencyExchange;
annotation(__Dymola_UnitDefinitions(
BaseUnit(symbol="EUR", quantity="currency"),
UnitConversion(

defineUnitConversion(from_unit="EUR", to_unit="SEK", scale=10.96),
defineUnitConversion(from_unit="EUR", to_unit="USD", scale=1.16))));

end Currencies;
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package Percentage
annotation(__Dymola_UnitDefinitions(
UnitConversion(

defineUnitConversion(from_unit="1", to_unit="%", scale=100))));
end Currencies;

package DiskSize
annotation( __Dymola_UnitDefinitions(

      BaseUnit(symbol="bit", quantity="information"),
UnitConversion(

defineUnitConversion(from_unit="bit", to_unit="byte", scale=0.125))));
end Currencies;



Für eine große CombiTime-
Table (20 Signale à 500 
Datenpunkte) reduziert sich 
der C-Code (Dateigröße) um 
Faktor 3 - 4 !

Arrays im Modellcode (C-code)

• Mit dem Flag Advanced.Beta.Translation.ArrayDeclare = true wird versucht Arrays im Modellcode 
(dsmodel.c) nicht auszuflachen

• Ggf. führt dies zu einer geringen Performanceverbesserung 

• Feature under development

• Nur für Daten-arrays nicht für Komponenten-arrays
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DeclareArray = trueDeclareArray = false



Schnellere Übersetzungzeiten 

• Dymola intern wurden Anpassungen durchgeführt, die das Übersetzen von Modellen beschleunigen. 

• Leider ist unbekannt, um was für Änderungen es sich dabei handelt und welche potentiellen Auswirkungen 
diese haben.

• Merkliche Verbesserung der Übersetzungsdauer in allen getesteten Bibliotheken

• *Kundenbibliothek 1 wurde im Vorfeld zur Analyse an Dassault übergeben, was zu dieser Verbesserung 
geführt hat

2025-12-10 Neuigkeiten Dymola 2026x 18



Minor Improvements

• Mit Advanced.Modelica.PedanticBus = true  wird ein Fehler (statt einer Warnung) 
ausgegeben, wenn ein Signal, dass im Bus definiert ist, nicht bedatet wird 
(angeschlossener Input).

2025-12-10 Neuigkeiten Dymola 2026x 19
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Makros für Legenden

Für Legenden von geplotteten Signalen können nun folgende Makros verwendet werden:
• %name  > Name des Signals
• %unit     > aktuelle DisplayUnit
• %desc   > Beschreibung der Variable

2025-12-10 Neuigkeiten Dymola 2026x 21



Auslesen von Registry-Keys

• Mit dem neuen Dymola Befehl getRegistryValue können Werte aus dem Windows 
Registierungs-Editor ausgelesen werden

2025-12-10 Neuigkeiten Dymola 2026x 22

getRegistryValue("HKEY_LOCAL_MACHINE\SOFTWARE\Dassault Systemes\Dymola 2026x",

"InstallDir",convert=true, defaultValue="defaultValue")

➔ "C:/Program Files/Dymola 2026x/"

• Convert=true wandelt Back-Slash in Slash um
• defaultValue wird ausgegeben, wenn der 

gesuchte RegistryValue nicht gefunden wird
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FMI & SSP

Neuigkeiten Dymola 2026x



Physikalische Konnektoren für ModelExchange-FMUs
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Model-Exchange FMUs können mit physikalischen Konnektoren exportiert werden (FMI 3.0) 

• Funktioniert nur für Konnektoren, die ausschließlich Fluss- und Potiential-größen 
enthalten

• Funktioniert nicht für Black-Box FMUs
Folgende Flags werden dazu benötigt:
Advanced.Beta.FMI3.IncludeTerminalsAndIcons= true
Advanced.FMI.AllowPhysicalConnectors = true;
Advanced.ExtendedStructuralCheck = false;
Advanced.ExtendedStructuralDiagnosis = false;
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Physikalische Konnektoren für ModelExchange-FMUs
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• Die FMU bleibt jedoch kausal:

• Wenn man den Connector-Anschluss mit der Outputgröße der FMU beaufschlagt (hier 
flange_{a/b}.s), wird rückwärts durch die FMU iteriert, d.h. die Kraft wird iterativ solange 
angepasst, bis sie den gewünschten Weg ergibt.

• Dies führt zu einem oder mehreren (nicht-)linearen Gleichungssystemen 
2025-12-10 Neuigkeiten Dymola 2026x 



FMI Functions als separate Bibliothek

• FMI Functions, wie fmi3DoStep, fmi3GetContinuousStates, etc. können nun als eigenständige Bibliothek 
geladen werden, anstatt Bestandteil der FMU zu sein.

• Dazu muss der Flag Advanced.Beta.FMI.ExternalLibrary = true gesetzt werden

• Somit verwenden alle geladenen FMUs die selben FMI-Functions, was ein effizienteres Übersetzen 
ermöglicht

2025-12-10 Neuigkeiten Dymola 2026x 26

ExternalLibrary = trueExternalLibrary = false



Minor improvements

Performance Analyse für FMUs mit Cvode und Ida

• CoSim FMU's mit Cvode oder Ida können nun den Integrationsfehler für die Zustandsgrößen 
ausgeben 
➔Performance Analyse möglich

Wie bei anderen Solvern muss dazu Simulation > Simulation Setup > Debug > "Debug settings 
included in translated or exported model" gesetzt werden 

Für Ida und Cvode muss zusätzlich Simulation > Simulation Setup > FMI Export -> store result in 
mat file gesetzt werden

Default-Name der FMU

Mit Advanced.FMI.ShortDefaultModelIdentifier = true wird per default nur der Modellname, statt 
dem gesamten Modelica-Pfad als Name der FMU verwendet:

PID_Controller.fmu statt Modelica_Blocks_Examples_PID_Controller.fmu
2025-12-10 Neuigkeiten Dymola 2026x 27



Minor improvements

SSP export 
• Modelle, die nur ein extend auf ein anderes Modell sind, werden als SSV exportiert (System 

Structure Values)
• Mit Advanced.Beta.SSP.ExportExternalBinding=2 wird das SSV File als eigenständige Datei 

herausgeschrieben und ist nicht Teil des SSP-Files
• Alle Modelle eines packages können nun auf einmal jeweils als SSP exportiert werden
• Export auch ohne zippen als SSP-file möglich: xml-Files etc. werden direkt ins Arbeitsverzeichnis 

geschrieben
• SSP Files enthalten nun auch Extras und Resources Ordner

SSP import
• Sofern das SSP-File keine Info über die Positionierung der Komponenten enthält, erfolgt eine 

automatische Positionierung

2025-12-10 Neuigkeiten Dymola 2026x 28
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Modelica Standard Library 4.1.0
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Dymola Version MSL Version
Dymola 2026x 4.1.0
Dymola 2025x 4.0.0
Dymola 2024x 4.0.0
Dymola 2023x 4.0.0
Dymola 2023 4.0.0
Dymola 2022x 4.0.0
Dymola 2022 4.0.0
Dymola 2021x 4.0.0
Dymola 2021 3.2.3
Dymola 2020x 3.2.3
Dymola 2020 3.2.3
Dymola 2019 FD01 3.2.2
Dymola 2017 3.2.2
Dymola 2016 FD01 3.2.1
Dymola 2014 FD01 3.2.1
Dymola 2014 3.2

MSL Version Release Date # Models/Blocks # Examples # Functions

4.1.0 2025-05-23 1430 534 1219

4.0.0 2020-06-04 1417 512 1219

3.2.3 2019-01-23 1288 404 1227

3.2.2 2016-04-03 1600 * 1350

3.2.1 2013-08-14 1360 * 1280

3.2 2010-10-25 1280 * 910

3.1 2009-08-14 923 * 615

* # Examples war in # Models/Blocks enthalten

Die MSL 4.0.0 ist nicht mehr standardmäßig in der Dymola Installation 
enthalten. 
Sie ist aber im "extra"-Ordner den Dymola-Installationsdateien beigefügt: 
(Dymola_2026x.AM_CAT_Dymola.Windows64.1-1.zip\ 
AM_CAT_Dymola.Windows64\1\extra) 
Alternativ können Sie sie aus einer älteren Dymola-Version kopieren oder 
hier herunterladen:
https://www.ltx.de/download/Dymola/ModelicaStandardLibrary_4.0.0.zip
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Übersicht: Bibliotheken in Dymola
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Modelica Standard Library PneumaticSystems ClaytexVeSyMA

ModelManagement ProcessModelling ClaytexEngines

DataFiles WindPower ClaytexPTDynamics

UserInteraction FlexibleBodies ClaytexSuspensions

Plot3D FlightDynamics ClaytexVeSyMA2EPTL

Design ClaRaPlus Visa2Base

Testing AviationSystems Visa2Paper 

DymolaModels Battery Visa2Steam

Modelica_LinearSystems2 BrushlessDCDrivers ClaRa_DCS

Modelica_StateGraph2 Cooling ClaRa_Grid

ModelicaDeviceDrivers DassaultSystems HumanComfortLib

Optimization ElectricPowerSystems HVACLib 

VehicleInterfaces ElectrifiedPowertrains Claytex

TILFileReader Hydrogen ClaytexFluid

TIL Suite ThermodynamicsConnector ClaytexFluidPower

FluidDynamicsLib SMArtInt

Änderungen gegenüber 
Dymola 2025x RF1

Keine Änderung

Änderungen nicht bekannt

Neue Features

BugFixes

Neue Features und BugFixes



Weitere Libraries (direkt über LTX)
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http://www.ltx.de/download/Modelica_Libraries_Catalog_LTX.pdf

Smart Int+

http://www.ltx.de/download/Modelica_Libraries_Catalog_LTX.pdf


Bibliothek zum Trainieren(+) und Verwenden von neuronalen Netzen in Modelica 
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physikalisches Modell
(z.B. Wärmeübergang)

Training Ersatzmodell & Verwendung

• Verschiedene neuronale Netze verfügbar (FF, (stateful) RNN, Neural ODE,...)
• Verschiedene Formate zum Import (ONNX & tflite)

• kostenlose, abgespeckte Version unter GitHub (https://github.com/xrg-simulation/SMArtIInt) verfügbar und in Clara+ 
enthalten 

• SmartInt+ ist kommerziell und kann von XRG Simulation GmbH bezogen werden (Training, ExtrapolationWarning, ....)

Simple Modelica Artificial Intelligence Interface



Sustainable Supply Systems
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Neue Bibliothek für Energiesysteme 

• Bibliothek zur Simulation von Energie-Versorgungs-Systemen
sowie Energie- und Resourcen- Management.

• Bewertung von 
• Energieverbrauch 
• wirtschaftliche Kosten 
• CO2 Emissionen

• Komponenten für unterschiedliche Energiequellen:
• Solar
• Wind 
• (fossile) Verbrennung

    und Verbraucher:
• Fahrzeuge
• Gebäude
• Fabriken
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Nächste Kurstermine
• Online-Kurs an jeweils vier Vormittagen „Introduction to Dymola and Modelica“

Auf Anfrage (deutsch oder englisch) 

• Kurs 2 Tage vor Ort in München „Multidisziplinäre Modellierung und Simulation mit Modelica und Dymola“ 
wird noch bekannt gegeben (Frühjahr 2026)

• Kurs „DLR Visualization Library und Modelica MultiBody“ (Auf Anfrage)

• Kurs „Einführung zu OpenModelica“(Auf Anfrage)

• Spezialkurse :

• Performance-Workshop: 25. & 26.02.2026 (online, jeweils Vormittags)

• Git&Modelica (auf Anfrage)

• FMI&FMPy (auf Anfrage)

Kursthemen für fortgeschrittene AnwenderInnen:
https://www.ltx.de/download/Kurs/Kursthemen-Fortgeschritten.html

• Aktuelle Termine unter www.kurse.ltx.de

• Anfragen und Anmeldungen gerne unter: kurse@ltx.de
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Release Notes

• Online:

https://ltx.de/download/Dymola/ReleaseNotes_Dymola2026x.pdf

• Dymola:

Help > Documentation > Dymola release notes

• Fünfteiliges Handbuch als ein PDF (für Suche):

http://www.ltx.de/download/Dymola/DymolaFullUserManual_Dymola2026x.pdf
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Download für Wartungskunden

von LTX:

www.ltx.de/download/Dymola/aktuell

Noch keine Login-Daten? 
Schreiben Sie an sales@ltx.de

von Dassault:

software.3ds.com
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https://ltx.de/download/Dymola/aktuell.html
mailto:sales@ltx.de
https://software.3ds.com/
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Danke für Ihre 
Aufmerksamkeit !
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Kontakt

• sales@ltx.de – Vertriebsanfragen, Wartungsangebote&-Rechnungen, Lizenz-Keys

• support@ltx.de – Technischer Support (SR), Verbesserungsvorschläge (ER)

• LTX Simulation GmbH

• Wohlfartstraße 21 b
80939 München
Deutschland

• Tel.: +49 89 20 97 00 55
info@ltx.de
www.ltx.de
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